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1 SAP GUI Security Module

The SAP GUI security module was implemented to protect the user’s local environment against undesired
actions that a potentially corrupt SAP system could trigger on his or her PC. The possibilities for the back-end
system to control the client PC are fundamentally desirable and they make using the SAP system significantly
easier. However, with the appropriate manipulation, they could also potentially be misused to run undesirable
or destructive commands on the PC(s) of one or more end users. This could, for example, lead to the
uncontrolled deletion of files, or an attacker gaining control of the PC.

To provide effective protection in this situation, without generally suppressing the local actions triggered from
the server side, SAP GUI for Windows has been enhanced with a special security module. With this module,
you can set the level of security in general, but also very specifically make settings for particular actions or
target files. You can also set “security rules” as required, and make them either generally valid, or restrict
them to individual systems or a group of systems. In this way, you can very precisely configure the security

of each individual PC with respect to its respective back-end systems. In particular, if you use the local

SAP GUI to connect to external SAP systems (for example, in collaboration scenarios), or if you are using

test or development systems, in which comparatively few security precautions have been taken, we would
recommend that you configure the security settings in this way.

Checked Object Types
The following list contains all object types for which a security check is available:

* File

* File extension

* Directory

* Registry key

* Registry value

* Environment variable
* ActiveX control

* Command line

* Shortcut file

1.1 SAP GUI Security Settings

A default security configuration is delivered with SAP GUI for Windows that suppresses many potentially
malicious actions and permits those that are clearly benign. However, in most cases, it will be necessary

to adjust this configuration to the requirements of your individual company. The SAP GUI security module
supports the administrator both in creating a configuration of this type and in distributing this file by providing
a central repository.
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1.2 Which actions triggered by the SAP system can be
controlled by the security module?

Fundamentally, it is technically possible and desirable that a program triggered by the back-end system can
open a local file and read, overwrite, or execute its contents. On the other hand, however, actions of this type
could eavesdrop on confidential information or destroy important settings. It is therefore important to evaluate
each individual process and to eliminate potential dangers.

The SAP GUI security module has three status levels:

Disabled: In this case, no checks take place, and each request received from the back-end system to read,
write, or execute a program is immediately executed. In this case, the end user will often not be aware that
an action triggered by the back-end system is being performed. This setting therefore involves the danger
that undesirable actions could be executed undetected, potentially causing damage. This setting is therefore
generally not recommended, but rather is suitable for very restricted system situations.

Strict Deny : This setting is the exact opposite of the previous setting and denies the execution of every
individual security related action triggered by the back-end system as well as the execution of SAP Shortcuts
or starting SAP GUI by command line unless it is explicitly permitted by a rule defined by SAP. The SAP rules
permit, for example, the user to call help for the application. In practice, it will often not be possible to use

this setting, since many SAP applications access resources on the client PC (downloads, uploads, execution of
programs, and so on) and the usage of SAP Shortcuts is quite common.

Customized : This setting is selected by SAP as the default setting when you install SAP GUI for Windows.

It has the consequence that when a request for an action is received from a back-end system, SAP GUI first
searches the list of entered security rules to evaluate the request, if possible. The security rules are processed
in accordance with their order in the list. Whenever a request to perform an action is received, SAP GUI
automatically works through the list of rules from the top to the bottom. If a suitable rule is found, SAP GUI
terminates its search. That is, rules below this point that could also be applicable are ignored.

* Ifthereis arule with regard to the requested action, SAP GUI will proceed in accordance with the
procedure defined in the rule, to execute the request, deny the request, or start a query dialog that allows
the user to explicitly decide in this case whether the request is to be executed or not.

* If there are no settings in the rules with regard to a particular action request, SAP GUI selects the default
action, as it is defined in SAP GUI. This will usually be the query dialog that leaves the decision about
execution to the user (Default Action = Ask). However, you can also choose to permit action requests for
which there are no rules (Default Action = Allow).

Example

You would like to prohibit all security related actions except the execution of SAP Shortcuts. In this case you
use the “Customized” setting together with “Default Action: Deny” and define a rule that allows the execution
of the SAP Shortcuts.

When doing so SAP Shortcuts can be used since a suitable rule for SAP Shortcuts is found, but for all other
actions no rule is found and therefore SAP GUI automatically denies these actions.
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1.3 Security Rules

You can use the Security Settings dialog in the Options dialog box of SAP GUI to change the security status and
to open the Security Configuration Dialog:

= SAP GUI Options - SAP Logon X
‘ Find a setting | Security
> Visual Design Security Module
> Interaction Design Status- TDisabled |
> Accessibility & Scripting Disabled
> Multilingual Settings [ Open Security Configuration J Customized
Strict Deny
> Local Data
> Traces Security Rule Status
v Security Default Action: Ask
Security Configuration
Yy _g SAP Rules: 458
> SAP Logon Options
> Front End Print Administrator Rules (Total/Disabled): | 27610 |
Restore & Cleanup User Rules (Total/Disabled): | 8/0 |
System Information

When you open the Security Configuration dialog you find a numbered list of all existing security rules:
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Security Configuration

Status . Custemized |
Default Action -ﬁ-sk v—|
Security Rules
| o)
[} Hide SAP Rulas "] Hida Administrator Rulas
Pr.. ~ Object Type: Access types: Acti... State  Origin: N
455 SIJABclient. SIJABcantral Contral Execite Allew  Enabl SAP
456 S1JABclisnt JavaManagerSink ontrol Executs Allow Enabl.. SAP
457 VisCarrSE_NETVisTransmitta Cantral Executa Allews  Enabl SAP
455 "R File E«ten Read, writs Con Enabl Administ 1
459 " asc File Exten Raad, write Con Enabl Administ 1
480 "ty Fila Exten Read, write Con Enabl Administ 1
461 “wal File Exten Read, write ~an Enabl Addminist 1
462 il File Exten Read, write oan Enabl Aclmimist 1
463 “jt Fil= Exten Read, write Con Enalbl Administ 1 l
o [SAP:Dacuments]” dos File Fead, write,... Con.. Enabl Administ 1
465 [SAP Documents]™ docm File Read, write Can Enabl Ackrmnist 1
4eb [SAP:Documents)” daot File Read, write Con.. Enabl.. Acdminist 1
457 [SAP:Documents]™ do Fil Fread, write Con.. Enabl Administ 1
468 [SAP:Dacuments]” File Fead, wrte Con Enabl Acdminist 1
- 5 antli® dots £ l

[ Insert ] [ Wiew ] Delete Increase Priority Decrease Priority

Cancel Apply Hel
) P

Origin - SAP: After the installation of SAP GUI/SAP Logon, there is already a large number of rules in the table.
These rules were created by SAP and delivered with SAP GUI. You cannot edit these rules, nor can you increase
or decrease the priority in the sequence of rules. This applies to both users and administrators. As long as the
security status Customized has been selected, these rules are taken into account. They protect important local
objects that are required for the operation of SAP GUI. These include, among other things, registry values or
specific XML files that contain configuration information.

Origin - Administrator: The administrator who is responsible for distributing SAP GUI has authorization to
create additional rules, which also cannot be changed or removed by the user.

Origin - User: As a SAP GUI user, you can create additional security rules for your local working environment.
The procedure for doing so is exactly the same as for the administrator.

i Note

By default, the dialogue shows only the user rules. The SAP rules and administrator rules (as shown in the
screenshot above) can be displayed via the checkboxes.
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1.4 Context-Dependent Rules

In addition to the possible SAP GUI reactions Allow and Ask described in Which actions triggered by the
SAP system can be controlled by the security module? [page 4], it is also possible to create a rule that is
context-dependent. Context-dependent means that certain restrictions apply to the rule, for example, that is
only applies for one or more defined SAP systems. A rule of this type is defined in a subsequent step, if the
Context-Dependent setting was chosen for the action when setting the security rule.

Rule Properties X
Origin: |
Type: ‘File v|
Object: ‘ |
Action: Context-Dependent | Access types: Context-Dependent |
[+ Rule is active

Security Rule Context

System Network Client Transaction Screen Na.. Screen Num... Accesstypes: Action: State

[ Insert J [ Delete ] Up Down

Use '/ as a path separator in directory, file, registry key, and registry value names.
Use '\' to escape the characters '[', '] and '\' in object names: for example, "\[" instead of [

Once a new context has been added to the table, all information related to the back-end system is usually
predefined using a placeholder.

You can use this table to very specifically restrict a security rule to a particular system, a particular transaction,
or even a particular screen. The access type, subsequent action, and status of the rule context are also
predefined with default values that you can adjust as required. The options Allow or Ask are available for
context-dependent actions, just as for general (non-context-dependent) security rules. Denial of requests
without an associated security rule context is not permitted for security rules created by administrators or
users. You need to set the status of the rule context to Enabled, since the rule context will otherwise not take
effect. The value of the field Network plays an important role when setting up the rule contexts. The predefined
setting for this field is an empty field, which means that the current rule context is valid for the local network.
A general placeholder in this field would expand the validity of the rule context to any networks. Note the
following notation for describing potentially affected networks:

Values for Network Field

Local Network

% Any external networks
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Values for Network Field

* Local and external networks

/H/../S/ ... Router string for precisely one defined network

You can create any number of rule-contexts for context-dependent security rules, meaning that you can also
design complex security scenarios. You can change the order of security rules not created by SAP in the list,
and therefore the chronological sequence in which they are processed. Note that the order in which rules are
processed can be particularly important if problems occur due to the use of the rules. This can, for example, be
the case if the contents of individual rules contradict each other. The rule contexts are also processed from the
top to the bottom.

Alternatively, rules can also be generated by executing security-relevant actions with the setting Status:
Customized and the Default Action: Ask. In this case, if there is no rule, a query is shown for the requested
action. The options available to the user depend on the action to be performed.

Example

The system is attempting to execute a file on the client PC. The user can now react to the query in the following
ways:

SAP GUI Security X

The system is attempting to execute the following program or display the following file:
C:\Users\d036\Desktop\temp.sap
Do you want to grant access to this program/file?

[] Remember My Decision

[F 51
[ Allow ]{ Deny ] Help
L <]

If the user’s decision applies only to the current situation (Allow/Deny without checked option Remember my
decision), there are no consequences for future queries of this type. However, if the user makes a permanent
decision for this type of query (Allow/Deny with checked option Remember my decision), a security rule is
automatically generated that corresponds to exactly the present situation. This rule is added to the end of the
existing list of rules and is taken into account for subsequent requests of this type. If Allow was selected, the
rule is automatically created with a rule context matching the current environment (system / transaction and
so forth). This is done to avoid the creation of generic security rules that allow the execution of an action which
may only be uncritical in certain systems / contexts.
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See also:

* Starting SAP GUI via SAP Shortcut or Command Line [page 13]
¢ ActiveX Objects [page 19]

1.5 Security Configuration via the Windows Registry

* The registry value SecurityLevel determines the status in which the security module is to run on the
respective PC:

Deactivated 0
Customized 1 (Default)
Strict Deny mode 2

The registry value SecurityLevel is of the type REG_DWORD. In Strict Deny mode only the security module
internal SAP rules will be processed. All actions not allowed by an SAP rule will be denied.

* The REG_DWORD registry value Configuration can be used to configure which sets of rules will be
considered during the check and in which order they will be processed.

Only administrator rules 0

1. Administrator rules 1 (Default)
2. Userrules

1. Userrules 2
2. Administrator rules

Only user rules 3

Security module internal rules delivered by SAP will be processed always before all other sets of rules.

* The REG_DWORD registry value DefaultAction can be used to configure what is to happen if no matching
rule was found:

Allow 0
Ask 1 (Default)
Deny 2

You can see what effects the denial has for the end user in the corresponding section of the End User
Guide. With the help of the dialogue one can find out, if a security rule has to be adapted or if a new one has
to be created.

* The REG_DWORD registry value DisplayNotifications can be used to configure the display of the
notification popup in case of denied requests:

SAP GUI Security Guide
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Off = No notification popup will be displayed when a 0
request was denied

On — A notification popup will be displayed when a 1 (Default)
request was denied

* The REG_EXPAND_SZ registry value InitSaveDir can be used to configure the default path and folder for
users to save the reported information in case of an access denial due to security rules. If users change
the default path and save the information to an individual location, this new path will be kept as long as the
user does not terminate the program. When starting SAP GUI again, users will get the configured default
path again to store the reported information, the individual path changes will be lost. If the registry value
does not exist, the default directory is the document directory of the SAP GUI.

By default none of the above registry values exists. In order to change the behavior of the security module, the
registry values need to be created and set to the desired value. A not existing registry value means use the
default.

You can use the registry values below the registry key:
[HKEY_LOCAL_MACHINE\Software\SAP\SAPGUI Front\SAP Frontend Server\Security]

to configure the behavior of the security module.

i Note

For 64 bit operating systems, when running a 32bit version of SAP GUI for Windows, please use the
following registry key:

[HKEY_LOCAL_MACHINE\SOF TWARE\Wow6432Node\SAP\SAPGUI Front\SAP Frontend Server\Security]

to configure the behavior of the security module.

1.6 Creation of a Rule File by the Administrator

To create arule file as an administrator, use the rule editor in the Security node of the SAP GUI options dialog.
The administrator can use the following settings to collect information for the creation of a rule file:

* The REG_DWORD registry value ActivateLogging can be used to activate the creation of a log file that
contains all security-relevant events for which security rules may have to be created. The administrator
may collect this information from some key users and create a security rule file out of this.

Off — Logging is deactivated 0 (Default)

On - Logging is activated 1

SAP GUI Security Guide
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If the logging was activated, the respective user will be informed about this fact by a special notification
popup:

.} J U WVITION

m
(o]

Environment information:
_ -Warking directory:
| Io 'C\Users\d036\0neDrive - SAP SE\Documents\SAP\SAP GUI'
[ vy - Trace level 3 activated
- Logging activated

For data security delete

| the settinais) as snon as nossihla |

This popup appears as soon as the user connects to a system and it is of the type top most, i.e. it will be
displayed on top of all windows open on the system. This popup is displayed, because, otherwise, the log
could be used for monitoring the activities of the user. The user can neither deactivate the logging nor
close the notification popup.

* The REG_EXPAND_SZ registry value LoggingDestinationDir can be used to configure the folder in which
the file will be written. Be aware, that the string may not contain a file name, that the configured folder has
to exist and that the users have to have write permission for this folder. The log files have the format.

sapsec<user ID>.log

"<user ID>"stands for the operating system user ID
You can use the registry values below the registry key:
[HKEY_LOCAL_MACHINE\Software\SAP\SAPGUI Front\SAP Frontend Server\Security]

to configure the behavior of the security module.

i Note

For 64 bit operating systems, when running a 32bit version of SAP GUI for Windows , please use the
following registry key:

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAP\SAPGUI Front\SAP Frontend Server\Security]
to configure the behavior of the security module.
The administrator can take the created security rules file from the directory %APPDATA%\SAP\Common

on his PC and deploy it to the client PCs or via a central repository as explained in Deploying the Security
Configuration / Central Repository [page 11].

1.7 Deploying the Security Configuration / Central
Repository

Security rules that are created for a large number of users can be centrally stored on a server by an
administrator. The administrator can use the registry values below under the registry key:

[HKEY_LOCAL_MACHINE\Software\SAP\SAPGUI Front\SAP Frontend Server\Security]

SAP GUI Security Guide
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to configure the behavior of the security module.

i Note

For 64 bit operating systems, when running a 32bit version of SAP GUI for Windows, please use the
following registry key:

[HKEY_LOCAL_MACHINE\SOF TWARE\Wow6432Node\SAP\SAPGUI Front\SAP Frontend Server\Security]
to configure the behavior of the security module.
The administrator can either deploy the customized security rules file saprules.xml file to a location of choice
on the client PC or the file can be placed in a central repository (file share / http(s) server).

The exact location needs to be specified via the registry REG_EXPAND_SZ value Location. The location value
contains only the path to the file, not the file name. This file name is predefined and cannot be changed by the
administrator.

The location can specified using a normal directory path or an URI (Uniform Resource Identifier) path notation.

i Note

IMPORTANT: Be aware that you have to ensure access security for the new file.

IMPORTANT: Do not replace the saprules.xml file in the installation directory of SAP GUI, since this will be
overwritten during a subsequent installation, for example of a patch.

The value Location needs to be placed under key

[HKEY_LOCAL_MACHINE\Software\SAP\SAPGUI Front\SAP Frontend Server\Security]

SAP GUI Security Guide
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2 Starting SAP GUI via SAP Shortcut or
Command Line

An attacker can theoretically abuse an SAP shortcut created to let the victim of the attack execute a function
in an SAP system without the user initially being aware of this. An attack of this type can happen under various
circumstances. The risk of this kind of attack depends on the nature of the application that is executed. More
information: SAP Note 1397000 #r.

The following section describes a mechanism that allows you to create detailed rules to control actions
triggered by SAP Shortcut.

Command Line Security Objects

To prevent an SAP system from an unauthorized access via

* SAP Shortcut file, or
* acommand line

Itis useful to create dedicated rules for those actions, that are explicitly allowed. A special set of security
object types was implemented that allows you to create this kind of rules.

If an SAP Shortcut file is trying to become executed, other rules will be checked as well, such as rules for file
objects, file extension objects or directory objects.

If no rules are defined for the respective command line security objects, a notification popup will be displayed
every time when a user starts SAP GUI via SAP Shortcut or Command Line. The user will be asked how to
handle the execution request:

SAP GUI Security X

SAP shortcut file

C:\Users\d036\Desktop\Y13 Spool Administration.sap
is being executed. SAP shortcut connection data:
System: Y13

Client: 000

OK code: /nSPAD

Do you want to log on to this system with the specified OK code?

[ ] Remember My Decision

Ira 51
o ) o]
L <
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i Note

The checking procedure will only be performed if the SAP shortcut was started from outside of SAP Logon
(Pad)!

Rules created automatically from the SAP GUI Security Dialog Selection

* Deny with checked option Remember my decision

If a Shortcut file was executed and the user selects Deny with checked option remember my decision, the
respective rule will automatically be created in the rules list:

Security Configuration

Status: liCustomized

Default Action: |Ask v |

Security Rules

[ Filter J [ Search J
[w] Hide SAP Rules [v| Hide Administrator Rules
Pri.. ~ Object: Type: Access types: Acti.. State  Or..
734 C:/Windows/sapmsg.ini File Read Con.. Enabl.. User
735 https://csswdf sap.corp/sap/support/notes/0120... File Execute Con... Enabl.. User
736 EJUsersdeSBIBesktoprB SPOOLADMINIS.. | SAP Short.. Execute Deny Enabl.. User
<> <>

View Delete Increase Priority Decrease Priority
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The rule will be created as a generic rule, it can be extended by specific Security Rule Context information:

Rule Properties X

Origin: |

Type: 'SAP Shortcut |

Object: ‘ C:/Users/d036/Desktop/Y13 SPOOL ADMINISTRATION.SAP |
Action: ‘ Deny ~ | Access types: ‘ Execute ~ |

[v] Rule is active
Security Rule Context
System Network Client Transaction Screen Na.. Screen Num... Access types: Action: State

Use '/" as a path separator in directory, file, registry key, and registry value names.
Use '\' to escape the characters '[', '] and '\' in object names: for example, "\[" instead of .

If the user selects Deny with checked option Remember my decision on the SAP GUI Security dialog selection,
the created rule will be valid generically for all contexts, no specific context information will be stored. In this
context, SAP GUI assumes that an action that was denied is likely perceived as a potential attack by the user
and, therefore, should never be executed.

* Allow with checked option Remember my decision

In this case the rule will be created only for the current context. Whenever the same request will be executed
within a different context (for example a different system or client), the user will be asked again. This is done to
avoid the creation of generic security rules that allow the execution of an action which may only be uncritical in
certain systems / contexts.

i Note

If you want to create a rule for a transaction that allows automatic execution of the first screen of the
transaction, i.e. the user does not see the first screen, the ‘*’ at the beginning of the OK code needs to

be escaped. This means that the transaction in a rule for command lines or SAP shortcuts needs to be
written as e.g. “\*se24" instead of “*se24”. Writing “*se24" would mean that starting a shortcut with any
transaction that ends on “se24" is allowed, e.g. “xse24” would be allowed.

If the executing object was of the type Command line, the SAP GUI Security popup will inform you respectively.
Also in this case you will have several options to respond. If you select selects Deny/Allow with checked

option Remember my decision, a corresponding rule will be created automatically. Again this rule is generic
per default and can be specified by declaring Security Rule Contexts (see above and see also SAP GUI help,
chapter Security Rules).
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i Note

If you create rules for Command line objects manually, please use the following declaration format:

/H /<host>/S/<service>

[/H/<host>[/S/<service>]/H /<host>/S/<service>

/R/<SID>/G/<group hame>

/M/<message server>/S/<service>/G/<group name>

SAP GUI Security Guide
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3 General Information about Transport
Layer Security between the Application
Server and SAP GUI

The data transfer between SAP GUI and the SAP Application Server is not encrypted by default.

SAP GUI communicates with the message servers of the SAP systems using the ports specified in the SAP Ul
Landscape file provided by the administrator. For connecting to the message servers, the ports specified in the
Messageserver items are used.

SAP GUI communicates with individual application servers via the sapdp</nstanceNumber> ports defined in
the local etc/services file. The SAP GUI installation writes these ports into the etc/services file with default
values 3200 until 3299 that should not be changed.

The ports used by any system to which a user has to connect must be open in firewalls between SAP GUI and
the SAP system.

To secure connections between SAP system components (for example, the application server on one side, SAP
GUI on the other side), use the SAP interface for Secure Network Communications (SNC). SNC supports the
SAP protocols dialog (DIAG) and RFC.

SNC offers the following protection:

* Authentication
The technical communication partners (client and servers) can be authenticated. With SNC, both partners
are always authenticated.

* Dataintegrity
The data being transferred between the client and the server is protected so that any manipulation of the
datais detected. Data integrity includes authentication.

* Data privacy
The data being transferred between the client and the server is also encrypted, which provides for
privacy protection. An eavesdropper cannot access the data. Data privacy includes data integrity and
authentication.

See also TCP/IP Ports of All SAP Products.

3.1 External Security Products for SNC

SNC is a software layer in the SAP system architecture that provides an interface to an external security
product. The interface used for the integration is the GSS-API V2 (Generic Security Service Application
Programming Interface Version 2).

To use SNC with SAP GUI for Windows, you must purchase a security product that has been certified by the
SAP Software Partner program or use SAP NetWeaver Single Sign-On. You can also use SNC Client Encryption
which enables encryption without Single Sign-On.
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More information:

* https:/www.sap.com/partner.htm| e
* http:/help.sap.com/nwssol0 (SAP NetWeaver Single Sign-On and SNC Client Encryption)
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4 SAP GUI File Security

4.1 Digital Signatures

The majority of files shipped as part of the SAP GUI delivery are digitally signed by SAP. The advantages of the
digital signature are:

* The publisher of a given file can be easily derived

¢ Files that have been modified by an attacker can be detected more easily since a modification of this kind
would break the digital signature

4.2 ActiveX Objects

SAP GUI for Windows is using ActiveX Controls (COM components) as the basis for many of the user interface
elements and components. ActiveX objects have been subject to security attacks in the past and, therefore,
need to be handled very carefully. There are multiple security mechanisms in SAP GUI for Windows to protect
from ActiveX based attacks. This includes the following two mechanisms:

Killbits

For the ActiveX controls that are shipped as part of the SAP GUI for Windows delivery, the “killbit” is set.

Killbits prevent the execution of ActiveX controls from within Microsoft Internet Explorer (more information:
http://support.microsoft.com/kb/240797 # ). Since many of the typical scenarios of attack are launched from
manipulated web pages that invoke insecure ActiveX controls, the killbits add a level of additional security to
SAP GUI for Windows. Setting the killbit does not mean that SAP GUI for Windows cannot be used from within a
Web browser (for example, in SAP Enterprise Portal).

Checking the validity of the registration of ActiveX Controls invoked by SAP GUI for Windows

Microsoft Windows allows the registration of ActiveX objects in the Windows registry under different root nodes
and arbitrary folders on the hard disk (some not requiring administrative permissions).

SAP GUI for Windows only uses own ActiveX objects from secure locations, but also requires 3rd party ActiveX
objects which cannot be secured by SAP. As of SAP GUI for Windows 7.70 patchlevel 9, SAP GUI for Windows,
therefore, checks every creation of an ActiveX object originating from a SAP GUI for Windows process for
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validity. In case a potentially unsafe registration of an ActiveX object is detected, SAP GUI for Windows displays
a security warning like this one:

SAP GUI for Windows

G Detected potential security threat related to the COM object
CLsip: <CLSID>

Registry path:
<Path>

File path:
<File Path>

Call comes from:
<Calling module>

Potentially threatening! Because file path is not in allowed folders list.

After you confirmed this dialog box, SAP GUI for Windows will abort.
Therefore, we recommend saving any unsaved work in SAP GUI for Windows now.

The user can save the work and after clicking the OK button, SAP GUI for Windows is terminated. In such
a case, an analysis needs to be performed based on the data on the security warning dialog and using the

information from the trace sapgui_hooks_api found in the SAP GUI for Windows trace folder. The respective
ActiveX object must either be stored in a secure location (like the Windows directory or the Program Files
directory and subfolders) or the registration of the object must be corrected.
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5 Local Files stored by SAP GUI for
Windows

5.1 Input History in SAP GUI for Windows

SAP GUI for Windows stores input typed by the user in a local history database that is secured by a password
not known to the user or the administrator. If critical information is typed, the input history can be either
completely deactivated or deactivated on an input field level by the administrator (more information: SAP
Notes 925639 and 924376/ ) or by the user on the current client PC via the extended context menu
(CTRL + Context Menu) by selecting Disable History. Passwords typed in password fields are never stored in
the history database.

5.2 Other Local Files

When working with SAP GUI for Windows different kinds of files are stored on the local hard disk. SAP Note
1442303 contains more information on the storage of the different types of files by SAP GUI for Windows.

SAP GUI for Windows does not automatically delete local files except for those downloaded into the temporary
items folder. Therefore the file / folder permissions on operating system level should be set up properly.

To comply with usual data protection rules it is additionally recommended to delete locally stored files
periodically.
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On the SAP GUI Options dialog File Lifetime you can configure easily the life time of locally stored data:

= SAP GUI Options - SAP Logon X
" Find a setting ‘ Local Data
> Visual Design Deletion of Files and Subfolders in Documents Folder
> Interaction Design "6) Vv T
PO . e L 4
» Accessibility & Scripting () Always during SAP Logon (Pad) shutdown
?Multiingual Settings () File lifetime (date modified) [days]:
» Local Data Directory for Documents:
History ;
\ C:\Users\DO3\Documents\SAP\SAP GUI ]
Cache
File Lifetime { Open Documents Folder
Local Tab Order
> Tracing Deletion of Files in Traces Folder
> Security () Never
> SAP Logon Options () Always during SAP Logon (Pad) shutdown
> Front-End Print () File lifetime (date created) [days]: ‘ 1
Restore & Cleanup Directory for Traces:

System Information \ C:\Users\DO3\AppData\Local\SAP\SAP GU\Traces\ ]

{ Open Traces Folder }

Deletion of Files from Chromium Edge Browser Control

{ Clear Browser Control Cache }

i Note

Deleting files should be done with caution. If you configure SAP GUI to automatically delete files when SAP
Logon (Pad) is closed, this may for example mean that content downloaded from the SAP system will not
be available anymore for other applications after closing SAP GUI. Our recommendation is to educate users
and configure a reasonable duration for the deletion of such content.

i Note

SAP GUI for Windows does not delete any files transferred to the client PC outside of SAP GUI's
documents / trace / temporary items folders. If a user copies items from these folders into other folders,
the responsibility for deleting the respective files, if they are no longer needed, moves to the user.

i Note

Files downloaded by ABAP applications through SAP GUI for Windows may contain sensitive data. Since
downloaded files are typically downloaded to process them in applications other than SAP GUI for Windows
(like Microsoft Excel) after the download, SAP GUI for Windows cannot encrypt such files. As mentioned
above, SAP GUI for Windows can delete files residing within the respective SAP GUI folders automatically,
but if this is not sufficient, we advise you to implement hard disk encryption (like Microsoft BitLocker for
example).
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5.3 Browser Controls

SAP GUI for Windows depends on browser controls shipped and installed by other software vendors. These
controls are used to display web content/applications inside SAP GUI for Windows. If such an application
downloads a file to the client, this file is copied to the user data folder of the used browser control. Depending
on what was downloaded by the user, such files may also contain sensitive or person-related data. The location
of downloaded content depends on the browser control setting in the SAP Options - SAP Logon tab. There are
two options as shown in the picture below:

* Internet Explorer
* Edge (based on Chromium)

= SAP GUI Options - SAP Logon X
| Find a setting | Interaction Design
> Visual Design Additional Control Services

~ Interaction Design
Keyboard Settings

[] Enable additional control services

Search Provider: |Google ~

Visualization 1

Visualization 2
Notifications HTML Control

Control Settings Browser Control: :_Edge (based on Chromium) -
Sound Settings Internet Explorer
- L Edge (based on Chromium)
Accessibility & Scripting
Multilingual Settings

Local Data

Traces

Security

SAP Logon Options
Front End Print
Restore & Cleanup

A Y " R Y "

System Information

Since SAP GUI is not aware of the content of such files, it is not possible to automatically delete such content.
Therefore, the user is responsible for cleaning up such files.

The browser control based on Internet Explorer uses the local data folders of the Internet Explorer. Therefore,
managing this content is possible through the Internet Explorer tools (| Tools » Safety ¥ Delete Browsing
History 3...).
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However, the browser control using Edge (based on Chromium) has an own user data folder located in
%LOCALAPPDATA%\SAP\SAP GUI\EdgeUserData. This can be cleared via the button Clear Browser Control
Cache in the SAP GUI options dialog placed on the Local Data - File Lifetime page:

= SAP GUI Options - SAP Logon X
" Find a setting ] Local Data
> Visual Design Deletion of Files and Subfolders in Documents Folder
> Interaction Design "(;) Never 1
PO . e L = 4
» Accessibility & Scripting () Always during SAP Logon (Pad) shutdown
?Multiingual Settings () File lifetime (date modified) [daysl:
» Local Data Directory for Documents:
History
[ C:\Users\DO3\Documents\SAP\SAP GUI ]
Cache
File Lifetime { Open Documents Folder
Local Tab Order
> Tracing Deletion of Files in Traces Folder
> Security () Never
> SAP Logon Options () Always during SAP Logon (Pad) shutdown
> Front-End Print () File lifetime (date created) [days]: 1
Restore & Cleanup Directory for Traces:
System Information [ C:\Users\DO3\AppData\Local\SAP\SAP GU\Traces\ ]
{ Open Traces Folder }
Deletion of Files from Chromium Edge Browser Control
{ Clear Browser Control Cache }
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6 Security Aspects of the HTML Control
Using Edge Based on Chromium
(WebView2 Control)

As of Version 7.70, SAP GUI for Windows offers a new browser control which is used to display HTML content
inside SAP GUI (see also SAP Note 2913405 ). This new control is using Microsoft's WebView?2 control (Edge
based on Chromium). This chapter covers the security aspects to be taken into account when using this
control.

Development Tools

The WebView?2 Control can offer access to the browser development tools (“Inspect™). By default, this feature
is disabled in SAP GUI, but it can be enabled if the development tools are needed.

The activation is achieved through setting registry value EdgeBrowsexEnableDevToolsWindow
(REG_DWORD) to 1.

This registry value can be located in

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\SAP\General (64bit operating systems when running a
32bit version of SAP GUI for Windows)

HKEY_LOCAL_MACHINE\SOFTWARE\SAP\General (32bit operating systems or 64bit operating systems
when running a 64bit version of SAP GUI for Windows)

HKEY_CURRENT_USER\SOFTWARE\SAP\General

The reading priority for this registry value is HKEY_LOCAL_MACHINE, then HKEY_CURRENT_USER and finally
the SAP GUI default (which is OFF).

Assuming that a user is not permitted to change registry values under HKEY_LOCAL_MACHINE, this means an
administrator can prohibit the usage of the feature by setting the value under HKEY_LOCAL_MACHINE to 0.

Local Files

For information on how to proceed with local files, see Browser Controls [page 23].

Microsoft Edge Extension “SAP GUI connector for Microsoft Edge”

As of SAP GUI for Windows 8.00, you can install a browser extension for Microsoft Edge from the Microsoft
Edge Add-Ons Store to connect SAP GUI for Windows with Microsoft Edge.
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This extension enables SAP GUI for Windows to open documents / URLs in a fully usable Microsoft Edge
window as opposed to the situation in SAP GUI for Windows 7.70, where only a very limited browser tab could
be used.

The extension receives service URL, redirect URL and SSO token from SAP GUI for Windows and forwards
this to Edge so it can be invoked by the browser. The communication between SAP GUI for Windows and the
browser extension is done via secured channels.

This feature can only be used when activated and when the respective Microsoft Edge extension is installed.
You can display the list of installed extensions in Microsoft Edge via the URL edge://extensions/.

When the extension is installed and activated it looks like this:

< Installed extensions / SAP GUI connector for Microsoft Edge

v SAP GUI connector for Microsoft Edge 0

. Size < 1 MB Version 1.0

Generally, browser extensions should be handled carefully and only installed / activated when used.
For further recommendations from Microsoft see also:

https://learn.microsoft.com/en-us/microsoft-365/security/defender-vulnerability-management/tvm-
browser-extensions #*

Required Permissions

“SAP GUI connector for Microsoft Edge"” requires only a single permission: “Communicate with cooperating
native applications”. This permission is needed to allow the communication between the extension and SAP
GUI for Windows.
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7  SAP GUI Scripting Security Guide

For more information about special security considerations relating to SAP GUI Scripting, refer to the
respective Security Guide available on the Online Help Portal.
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

®  Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:
®  The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
®  SAPdoes not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.
L]

Links with the icon ’h": You are leaving the documentation for that particular SAP product or service and are entering an SAP-hosted Web site. By using
such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Videos Hosted on External Platforms

Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any
advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within
the control or responsibility of SAP.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Bias-Free Language

SAP supports a culture of diversity and inclusion. Whenever possible, we use unbiased language in our documentation to refer to people of all cultures, ethnicities,
genders, and abilities.
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